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Introduction 
This technical support note is intended to give the user an understanding of how to integrate the F809F 
diagnostic module into the CS3000 from Yokogawa. 

References 
INM F809F  FOUNDATION fieldbus   diagnostics module manual. 
 
FOUNDATION fieldbus   is a trademark of the Fieldbus Foundation 

Overview 
This document is intended to provide details of how the F809F module easily integrates into the Yokogawa 
control platform and PRM. The F809F fieldbus module monitors the health of fieldbus segments and 
provides an indication of possible network failure.   
The Technical Support Note provides a detailed description of the many options for integration of the F809F 
diagnostic module into the Yokogawa system.   
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1 Hardware Requirements / Installation 

1.1 Installation for communication 
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1.2 Configuration of fieldbus communication segment 
 
The F809F is shipped preconfigured to 
communicate on segment 8. 
The communication segment that will be used 
may be changed by configuring the connector 
on the front face of the module. A 6 pin comb, 
supplied with the module is used to define the 
communication segment by inserting it one of 
the two ways into the connector. 
For communication on segment 8, place the 
comb in the connector so that the number 8 is 
visible on the top left surface. 
For communication on segment 1, place the 
comb in the connector so that the number 1 is 
visible on the top left surface. 

For communication on a separate segment , 
remove the comb and connect the segment to 
connections 3+4 in the top connector or, in 
some cases, through dedicated connectors on 
the carrier.  See INMF809F for further details. 
 

 
 

2 DD File: Tool for Fieldbus associated files  
 
To load the DD file in the CS3000 we need to launch the Fieldbus associated files tool. To do so click 
on Start – Alls Programs – YOKOGAWA CENTUM – Copy Tool for Fieldbus associated files 
 

 
Launch the DD Tool from windows 
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Select the source files, you should select here the FFO and the CFF files 
 

 
Select FFO and CFF files for the FF device 

And choose the destination folder. The destination folder is the CFDDFILE in your project directory. 
 

 
Project directory c:\CS3000\bkproject\mtl1\fieldbus\cfddfile 
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3 Workstation and controller configuration 
System view is the engineering tool where you will configure the Hardware, the Fieldbus Module, the 
I/O and where you will launch different tools to develop the control strategy, build the graphic windows 
and configure the FOUNDATION fieldbusTM H1 segment. 
 

 
System view 

Once you have added the ALF111 Fieldbus communication card, double click on the ALF111-1  icon 
in order to launch the Fieldbus Builder. 

 
System view – ALF111-1 
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Fieldbus Builder is the tool that will allow you to do the segment management and the device 
registration.  

 
Fieldbus Builder 

4 Fieldbus devices 

4.1 Fieldbus Devices General Information 
 
Each fieldbus device must have a unique physical device tag and a corresponding network address. 
The device tag is assigned to the device when it is commissioned and (for most devices), the device 
retains the tag in its memory when it is disconnected. The network address is the current address that 
the fieldbus is using for the device. The Fieldbus Foundation uses addresses in the range 0-255.  

  Basic device - sends and receives messages on the fieldbus but does not control when 
devices have access to the fieldbus. The F809F diagnostic module is a basic device. 

  Link Master - controls when devices access the fieldbus and executes the link schedule 
which synchronizes communications with function block execution on the fieldbus. Link Master 
devices are capable of taking over as LAS if the Primary Link Master device fails.  
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4.2 Device Descriptions and Methods 

4.2.1 Device Description 
A Device Description is similar to a driver for a device. For fieldbus devices, the Device Description 
includes the calibration procedures, parameter procedures, and other information required by the 
control system to communicate with the fieldbus device. The host system such as the CS3000 system 
uses library functions called Device Description Services to read the Device Descriptions. Device 
Description technology enables interoperability among fieldbus devices. Interoperability, a key benefit 
of fieldbus technology, is the ability of a host system to operate multiple devices, independent of 
manufacturer, on the same fieldbus segment without loss of minimum functionality. 
The CS3000 system supports a number of fieldbus devices from different manufacturers. The device 
description files necessary to support these devices are included in the CS3000. If a fieldbus device is 
not included in the CS3000, you must install the device description for that device. The device 
description is specific to the device type and revision.  

4.2.2 Methods 
Device Descriptions can also include a set of processing routines called Methods. Methods provide a 
way to access and manipulate parameters within a device. For example a DD for a Valve Controller 
might include methods for automatically calibrating valve travel, manually calibrating travel, restarting 
a device, and calibrating the internal pressure sensor information for display. Methods are available 
from the DD viewer in PRM. 
There are 3 configuration methods available in the MTL F809F Systems Transducer block.  

o Setting Date and Time 

o Resetting retransmission counter 

o Deleting device data 

4.3 Autosensing Fieldbus Devices or manual registration 
 
The H1 card automatically detects the fieldbus devices, recognizes the device types, and makes this 
information available to the CS3000. 
By default the CS3000 is configured with a value of 4 for the MaxResponseDelay some devices needs 
more than 4 and will not be automatically detected. In this situation the user needs to add the device 
manually .  
The F809F for example needs a value of 5 for the MaxResponseDelay and by default will not be 
detected by the CS3000 such devices need to be installed manually in the CS3000 or we need to 
manually change the MaxReponseDelay to 5 first. 
Manual registration of Fieldbus devices can be carried out even when the Fieldbus devices are not 
connected to Fieldbus segments. 
The following steps explain the sequence of manual registration by going through each procedure. 
In Tree View of Fieldbus Builder, select the segment to which a Fieldbus device is to be added by 
clicking the right mouse button in order to display the pop-up menu and select [Add Device]. 
Alternatively, select the segment and then [Add Device] from the [Device Registration] menu. The 
“Manual Registration dialog box” is displayed. (see screenshot) 
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Manual registration 

 
Tree View on the left side of the “Manual Registration dialog box” displays folders where 
capabilities files are stored along with sub-folders, etc. Select “Manufacturer ID” so that 
“Device Type” will be expanded and displayed, for the F809F select 0BE0EC (MTL) and select 0001 
(F809F).  
A list of Fieldbus devices that can be registered is in the list on the right side. The figure above 
shows the “Manual Registration dialog box” that displays the Fieldbus device list. 
Select the device to be registered from the displayed Fieldbus devices and click the [OK] 
button. The Enter Device Information dialog box is displayed 
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Device ID 
Enter the device ID. This information is required when performing tag assignment. It is also acceptable 
to keep the device blank. 
Device Tag Name 
Enter the device tag name of the selected device. 
Node Address 
The node address of the selected device is displayed. Change this information as necessary. In 
normal cases, it is not necessary to change this information. 
Device Class 
The device class of the selected device is displayed. This value indicates the communication ability of 
the Fieldbus device. Change this value as necessary. In normal cases, it is not necessary to change 
this value. 
Template File 
The default template file will be displayed. However, a different template can be selected if required. 

 
When a device is added, the NM parameter value is recalculated according to the capability of the 
device described in the capability file. If the calculation results in a change to a lower capability (the 
value becomes larger), a dialog box to confirm the device addition is displayed. Select [Yes] to add the 
device, and [No] to cancel the device addition. If the calculation results in a change to a higher 
capability, the current value rather than the result of the recalculation, is used to register the device. 
If the capability becomes lower when [Make NM Parameter the optimum value] is designated in the 
Environment Settings dialog box, the parameter cannot be automatically changed even by selecting 
[Yes]. The registration will be cancelled automatically in this case. If the capability becomes higher, the 
device is registered. 
 

 
Download the configuration 
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Change MaxResponse Delay, click OK 

 
To see what the setting is for the MaxResponse delay time, select the segment number in the 
Fieldbus Builder expand Common and select NM. It should be set to 5 when you use the F809F. 
 

 
NM parameters 
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Download options, check both boxes 

 
Offline download and download to the fieldbus devices have different meanings. Moreover, offline 
initial download and offline master data download are also different.  
The details as well as the downloading operations are explained as follows. 
Offline master data download means to download all the configuration data on the fieldbus builders 
and function block builders to the fieldbus device. 
Offline initial download means to import the local parameters of the fieldbus device first to the fieldbus 
builder and then to download the configuration data on the fieldbus builders and function block 
builders to the fieldbus device. 
Initial download is used for the first time downloading to the fieldbus device after the fieldbus device is 
connected. With the template of the fieldbus device, the initial downloading can be performed 
according to the equalization directions described in the template. 
When changing environment, the tag assignment, address assignment can be performed for offline 
download. Thus, the offline download can be performed to a segment, a field device or a function 
block. 
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4.4 PRM setup tool 
 
Logon Windows using an account with the Administrator privilege. 
Click [Start] > [All Programs] > [YOKOGAWA PRM] > [Tools] > [PRM Setup Tool] to start 
PRM Setup Tool. 

 
Start PRM Setup Tool 

4.4.1 Setup Device Path 
The Field Communication Server connects the field devices through the communication path 
which is defined by device path. 
In the left pane of PRM Setup Tool, select [Yokogawa PRM] > [Field Communication] > [<Device 
Path>] to display the window for setup the device path 

 
Device Path 

Right Click on Device Path and select New 
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Add the system type and the project name. The project name should be the same as the CS3000 
project name (MTL1) and click OK 
 

 
 

 
Create the system and project configuration 

 
Right click on the project name (MTL1) and select New. 
Choose the FCS type, enter the domain and the station number of the FCS 
Click OK 
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FCS type, Domain and Station number 

 
Right click on the FCS select New. 
Create the Node Number (1) and click OK 
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Add the Node 

To add a new I/O module in the newly-created node, right-click on the node and select [New]. 
Select [ALF111] in the IOM Type drop-down list. 
Enter the slot number of the ALF111 in the [Slot No.] field. 
Click [OK]. 
An ALF111 I/O module appears under the node, with four channels automatically created. 
To save the change to the device path configuration file, click [Apply]. 
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4.4.2 DD Copy tool 
DD files for FF-H1 devices that are available from the Fieldbus FoundationTM at the time of shipment of 
your PRM product are included in the PRM installation disks and will be copied to the computer when 
PRM is installed. 
 
You can use the DD Copy Tool for FOUNDATION fieldbus Devices to: 
• Update existing DD files to the latest versions. 
• Import new DD files that are not bundled in the PRM installation discs. 
This tool is available on a computer installed with PRM Client or Field Communications Server: 
 
To copy DD files for FF-H1 devices launch the PRM setup tool again as describe earlier and select the 
DD Copy Tools program. 
 

 
 
1. In the left pane, select [Yokogawa PRM] > [Field Communication] > [DD Copy Tools]. 
2. In the right pane, click [Copy DD Files for FOUNDATION fieldbus Devices]. 
The following dialog box appears. 
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DD Copy tool 

Specify whether to copy files or a folder. 
• When [Copy folders] is selected: 
All subfolders and files in the selected folder will be copied to the copy destination folder. 
• When [Copy files] is selected: 
A subfolder will be automatically created in the copy destination folder in accordance with the 
FOUNDATION fieldbus specification, and DD files will be copied to this subfolder. 
 
Select files or folders to copy from. 
• When [Copy folders] is selected: 
Clicking the [Browse] button will open the Browse for Folder dialog box. Select the top folder to copy 
from. 
• When [Copy files] is selected: 
Clicking the [Browse] button will open the Select Copy Source Files dialog box. You can select DD 
files (*.ffo) and capability files (*.cff) of names conforming to the FOUNDATION fieldbus specification. 
You can select multiple files to be copied. 
Each DD file (*.ffo) must have a symbol file (*.sym) of the same name. 
 
Select a copy destination folder. 
The top directory for installing DD files is already entered by default. 
• When [Copy folders] is selected: 
Specify the destination folder  
• When [Copy files] is selected: 
Specify “<PRM installation folder>\DD.” Normally, you need not change the default directory. 
If the setting is correct, the selected files or folders will be copied to the copy destination. 
Select the [OK] button. 
 
The files or folders will be copied. If any folder or file of the same name already exists in the 
copy destination, an overwrite confirmation dialog box will appear. Check the message, and 
select whether or not to overwrite the existing folder/file. 
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4.5 Plant Resource Manager 
PRM provides the following functionalities for performing online adjustments of device parameters. 
The word “online” means that adjustments can be performed remotely using PRM Client, without 
having to be at the physical location of the device. 
• Parameter Manager 
• Device Type Manager (DTM) Works 
• DD menu 
 

 
Relationships between parameter adjustment features 

 
 

4.5.1 Device registration method 
You need to register a device before you can manage it on PRM. Upon registration, the device 
appears in the Device Navigator, and you can use various PRM functions applicable for that device. 
This chapter describes the various methods to register devices. 
 
Plug & Play 
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Plug & Play is a PRM feature that automatically detects field communication devices connected to 
PRM through the Field Communications Server, and registers the devices in PRM. Plug & Play also 
reads the device paths on the field network, and represent them as device path hierarchy nodes on 
the Network view, which detected devices placed under the appropriate device path hierarchy nodes. 
Plug & Play is the most convenient method to register devices as the system reads in all required 
information and performs device registration at the same time. You do not need to do any manual data 
entry after running Plug & Play. 
 
Follow these steps to run Plug & Play: 
Click [Network] in the Device Navigator toolbar. 
The Device Navigator displays the Network view. 
Select the PLANT node, and select [Foundation Fieldbus] if you only want to perform Plug & Play for 
FF-H1 devices. 
Select the device node for which you want to do Plug & Play. PRM performs Plug & Play for 
the selected node and all its child nodes. You can also select only the ALF111 card where you want to 
perform the Plug & Play or the segment as shown below. 
 

 
Plug and Play 

 
Plug & Play may take a long time to complete, depending on the number of devices detected. 



 Technical Support Note No. 602 
04th November 2008 Rev 1 
 

  Measurement Technology Ltd,  Great Marlings, Butterfield, Luton, Beds England LU2 8DL TF 
 

Page 22 of 48 

 
Plug & Play Reading blocks 

 

4.5.2 Using Parameter Manager 

4.5.2.1 Resource Block 
The resource block defines the physical resources of the device including type of measurement, 
memory, etc. The resource block also defines functionality, such as shed times, that is common 
across multiple blocks. The block has no linkable inputs or outputs. 
The resource block supports two modes of operation as defined by the MODE_BLK parameter: 
Automatic (Auto): The block is processing its normal background memory checks. In this mode, 
changes can be made to all configurable parameters. 
Out of Service (OOS): The block is not processing its tasks. The BLOCK_ERR parameter shows Out 
Of Service. In this mode, changes can be made to any configurable parameter.  
 
In normal operation, the Block should be in AUTO.  
 
Click on the resource block TAB to view the parameters. 
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Resource block Tab 

 

 
Resource block Tab, software and firmware revisions 

Identification Measurement Software: Identification of the F809F measurement board (1.12) 
Identification Fieldbus Software version: Identification of the F809F fieldbus communication card (304 
Dec = 130 Hex version 1.30) 
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4.5.2.2 Transducer blocks 
There are two types of transducer block in our device: 

  Sys TB: System Transducer Block 
  Seg TB: Segment Transducer Block 

 
The transducer block supports two modes of operation as defined by the MODE_BLK parameter 

  Automatic (Auto): The block is processing its normal background memory checks. In this 
mode, changes can be made to all configurable parameters. 

  Out of Service (OOS): The block is not processing its tasks. The BLOCK_ERR parameter 
shows Out Of Service.  

 
In normal operation these blocks should be in AUTO. In order to change the actual mode, you can 
open the transducer block and change the actual mode with the actual mode field or you can select all 
the blocks you want to modify the mode, right click and then select activate, selected items. 
 

 
Block mode  
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4.5.2.3 Transducer Block Alarm Detection 
If any alarm (except the new and removed device alerts) is set within the Transducer Block then the  
“NEED MAINTENANCE SOON BIT” is set in the BLOCK_ERR parameter. 
Additionally, if any alarm is set in the Transducer Block, then the Segment alarm DI BLOCK PV_D will 
be set to 1. See chapter “configuring the DI block in the fieldbus cyclic messaging”. 
 
 

 
Device Need Maintenance Soon in Segment 1 Transducer Block 
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4.5.2.4 System Transducer Block (SysTB) 
There is one Sys TB in the F809F, which allows the user to view system and self-test alarms together 
with the system power feed voltages and temperature. The SysTB allows configuration of the time, the 
date and the segments monitored. Additionally, for each device on each of the 8 monitored fieldbus 
segments, the retransmission counter can be reset and device history data can be deleted from within 
this block. 

 
System Transducer block: Measurement values for the bulk power supplies and temperature 

 
System Transducer block: Alarm limits and monitored segment 
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4.5.2.5 Segment Transducer Block (SegTB) 
Each of the eight monitored segments are supported by a Seg TB that provides all the measured 
parameters and associated alarms for the fieldbus segment and devices. You can assign segment 
and device tags within this block. 
The segment and device alarm limits may also be changed in this block. 
Warning: the tags are held in volatile memory. If both power feeds fail at the same time, or the F809F 
is removed from the carrier, then the segment and device tag data will be lost.  This data will then 
require to be downloaded from the PRM database to the F809F. 

 
Segment tag and segment measurements, information on the LAS 

 



 Technical Support Note No. 602 
04th November 2008 Rev 1 
 

  Measurement Technology Ltd,  Great Marlings, Butterfield, Luton, Beds England LU2 8DL TF 
 

Page 28 of 48 

 
Device data for 32 devices 

 
 

 

 
Segment alarms and Device alarms 
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Segment alarm limits 

4.5.2.6 Custom TAB 
 
You can configure the Parameter Manager to display up to five custom tabs for each device model. 
Each custom tab can be customized to display a certain set of parameters of your choice. 
The Parameter Manager displays a single custom tab, labelled Custom, for each model of device, by 
default. You can choose to add more custom tabs, and to rename the custom tabs. To configure the 
custom tabs for a particular device model: 
1. View either a saved parameter set or the actual parameters of any device of the required model. 
The Parameter Manager displays the selected parameter set. 
2. Select [Tools] > [Custom Tab Settings]. 
The Custom Tab Settings dialog box appears. 

 
Select the number of custom tabs to display in the Number of Sheets field. You can select a number 
from 1 to 5. 
The dialog displays a default label for each custom tab. You can rename the tabs by entering the 
desired name in the label fields. 
4. Click [OK]. 
The Parameter Manager displays the appropriate number of custom tabs. 
5. Select [File] > [Save Custom Tab Info]. 
The settings are saved, and affect all devices of that particular model. 
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Adding parameters to a custom tab 
1. Right-click on the parameter name and select [Send to Custom Tab] > [<Name of custom 
tab>]. 

 
The parameter appears in the selected custom tab. 
2. Select [File] > [Save Custom Tab Info] to save your changes. 
 
 

 
 

 
Segment Alarm custom TAB 
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Device Alarms custom Tab 

4.5.3 DD menu (Methods) 
Device Descriptions can also include a set of processing routines called Methods. Methods provide a 
way to access and manipulate parameters within a device. For example a DD for a Valve Controller 
might include methods for automatically calibrating valve travel, manually calibrating travel, restarting 
a device, and calibrating the internal pressure sensor information for display.  
PRM displays DD methods of FF-H1 devices in a hierarchical menu format. 
 
You can open DD Menu from either Device Navigator or the Tool window. 
Opening from Device Navigator 
1. Right-click on the device in the Device Navigator and select [DD Menu]. 
The DD Menu window appears. 
 
Opening from Tool window 
1. Select a device from Device Navigator. 
2. On the function toolbar, click [Tool]. 
The Tool window appears 
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Tool: DD Menu 

3. In the Tool window, click [DD Menu]. 
The DD Menu window appears. 
The following figure shows the DD Menu  

 
DD Menu 

DD menus of a device are displayed in a tree structure in the menu tree display area. The following list 
shows the elements that are displayed in the tree structure 
• Device tag name 
• Block tag name 
• Menu name 
• Sub-menu name 
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To view the methods for the F809F expand the system transducer block folder and click on the 
METHODS sub menu as shown below. 
 

 
DD Menu: F809F methods 

 
There are 3 configuration methods available in the MTL F809F Systems Transducer block.  
• Setting Date and Time 
• Resetting retransmission counter 
• Deleting device data 
 
Double click on the required method. In this example, Reset retransmit counters was selected 
 

 
 

Choose the required option, in our example we’ll choose option 3 (desired segment) 
 

  All retransmission counters: Delete all counters 
  Desired segment and all its devices: Delete counters for one complete segment with all 

devices 
  Desired segment: Delete counters for the segment (keep the devices counters) 

Desired device on a specific segment: Delete counter for a specific device only 
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Desired segment 

4.5.4 Device Viewer 
DeviceViewer utilizes the device configuration file provided by the device vendor to display diagnostic 
and trend information about FF-H1 and HART devices. It uses colours to display the status level of the 
device and the status level of each device parameter. DeviceViewer also creates a trend graph based 
from the parameter values. 
DeviceViewer can either retrieve the most recent parameter values or retrieve parameter values 
periodically based on a specified time. 
The device configuration file identifies the standard parameters, and custom parameters which are 
added by the device vendor to enhance device features. Without the configuration file, DeviceViewer 
will only display the information for standard parameters. 
 
You can start up to five DeviceViewer windows in PRM at any one time.  
 
From the context menu 
From any PRM view, right-click an FF-H1 or a HART device, and then select [DeviceViewer] to 
start DeviceViewer. 
From the Tool window 
To start DeviceViewer from the Tool window: 
1. In PRM’s Network View, select an FF-H1 or a HART device. 
2. Click [Tool] in the function toolbar. The Tool window appears in the right-pane. 
3. In the Tool window, click [Device Viewer]. 
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Launch Device Viewer 

 
In the Diagnostic Information tab, you can view the status level of each parameter defined in the 
device configuration file. When you select the Diagnostic Information tab, the appropriate toolbar 
buttons appear. Components of the Diagnostic Information tab include Alarm Display, Diagnostic 
Parameter List, and Parameter List. 

 
 

 
F809F device viewer 

Diagnostic parameter list 

Parameter list 
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The parameters that appear in the Diagnostic Parameter List are derived from the device configuration 
file provided by the vendor. In DeviceViewer, you can view the status level of parameters included in 
this list. Colours are used to indicate the status level of a device parameter. 
When you mouse over a parameter, the Online Help appears displaying a detailed description about 
the parameter. 
The device configuration file organizes parameters into groups. A parameter group heading appears 
on each group. The most critical status level in the group is used as the status level of the parameter 
group heading. on each group. The most critical status level in the group is used as the status level of 
the parameter group heading. In our config file we have 10 groups, one for the Resource file, one for 
the System Transducer block and one for each segment. 
The following table displays DeviceViewer’s colours used for each status level. Error, the most critical 
level, is represented by the red colour. All parameter status levels appear in grey colour when there is 
communication error with the device or it is not connected. 
 
Default Status Level  Color 
Normal Green 
Warning Yellow 
Error Red 
Communication Error Grey 
 
The Parameter List displays the additional parameters identified in the device configuration file. 
These parameters are also displayed in the trend graph. It includes several columns that display 
specific values about the parameter.  

 
 
 

 
Warning in the Device viewer, segment 1 voltage low alarm 
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When you hover the mouse over a parameter, the Online Help appears displaying a detailed 
description 
. 

 
Online Help 
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4.5.4.1 Trend graph 
In the Trend Information tab, you can view the trend for specific parameters identified in the device 
configuration file. A trend line enables you to monitor diagnostic results and predict changes. You can 
then make appropriate adjustments to a device. 
When you select the Trend Information tab, the appropriate toolbar buttons appear. The Trend 
Information tab is divided into the Trend graph, which shows the trend, and the Trend parameter list. 
Parameters in the Trend parameter list provide the information to appear in the graph.  
 

 
Trend information TAB 

 

4.6 Discrete Input Block 
The discrete input blocks’ PV_D value is calculated from the current value of the alarm parameters of 
the transducer blocks and the OUT_D value is calculated according to the Discrete Input Block 
algorithm. 
 
  Alarm DI Block: PV_D will be set to 1 if any system alarm, segment / device alarm or self-test fault 

alarm bits are set. Selected by channel value 12. 
  System Alarm DI Block: PV_D will be set to 1 if any System alarm and self-test fault alarm bits are 

set. Selected by channel value 13. 
  Segment Alarm DI Block 1-8: PV_D will be set to 1 if any of the segment / device alarm bits are 

set for the specific segment. Selected by channel value 14 – 21 for segments 1 – 8. 
 

Trend 
parameter list 

Trend graph 
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In order to use the DI block you need to create a control drawing. To create a control block drawing, 
go to system view, Function block and edit a new drawing. 
 

 
System View, function blocks 

 

 
DI function blocks in the Control Drawing builder 
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In the above screenshot, we have used the 8 F809F DI function blocks for the segment alarms. The 
function block type is a FF-DI. To link the FF-DI block to the F809F DI function block, right click on the 
block and edit details. 
 

 
Function block detail builder 

In the example above, the Segment-ALARM FF-DI block is linked to the F809F_080301500 DI_03 
function block. 
 
Once the FF-DI block is created we can create an annunciator message in order to display the Alarm 
status in the historical report. 
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Annunciator configuration 

 

 
We created 9 messages,  

If the SEG1AL internal TAG is set to one, the historical report will display SEGMENT 1 ALARM (as 
shown below) 
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Historical report 

 
 

 
Logic chart for the annunciator 
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Logic chart block details 

The segment alarm value will set the annunciator variable 

4.7 F809F diagnostic parameters in the FCS 
Because the F809F is a diagnostic module, the FCS can have access to all FOUNDATION fieldbus 
parameters read by the diagnostic module. %Z variable should be used in order to bring these 
parameters to the FCS. 
48 %Z variables can be used per each ALF111 segment. 
 

 
Terminal assignment 

In our application, we’ll use 9 F809F diagnostic parameters: 

Number of %Z used for 
this segment 

Name of the Transducer 
block

Parameter’s 
name 
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 LAS Device address 
 Peak FF Noise 
 Average FF Noise 
 LAS signal level 
 Retransmission rate 
 Segment Voltage 
 Module Temperature 
 Power feed A and B voltage 
 
Once created these 9 variables are accessible in the Function block control builder in order to convert 
them in process variables (PVI) and use them as all process variable with faceplates, trends….. 
 

 
%Z as process variables 

 
%Z011145 will be the SEG-VOLT process variable 
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F809F diagnostic parameters in the HIS 

4.7.1 Trend F809F diagnostic parameters 
The Trend window acquires different types of process data and displays time-series changes in a 
graph. The time-series changes for the acquired process data are referred to as trend data. 
In a Trend window, a maximum of eight channels of trend data may be displayed. 
 
To acquire trend data, the following items must be defined on the definition builders: 
• System View 
Defines the acquisition type and sampling period for each block in the property tab of the Trend 
Acquisition Pen Assignment Builder when creating a new HIS. 
• Trend Acquisition Pen Assignment Builder: 
Defines the assignment of trend acquisition pens for each Trend window. 
 
All data items, such as PV (CPV), SV, MV and FV, are regarded as target process data of trend 
acquisition. The PVI we have just created for the F809F could of course be trend. 
The sampling period of process data are specified for each trend block. The sampling period can be 
selected from 1 second, 10 seconds, 1 minute, 2 minutes, 5 minutes or 10 minutes. No more than 18 
blocks can be specified with the sampling periods of 1 minute, 2 minutes, 5 minutes and 10 minutes. 
No more than 8 trend blocks can be specified with the sampling period of 1 second or 10 seconds. (*1) 
The trend data that may be used as closing data can have sampling periods of 1 minute, 2 minutes, 5 
minutes and 10 minutes. 
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To create trends, select the HIS, configuration and the trend block number (TR0001 in our case) 

 
To edit the Trend properties, Right click on TR0001 and select Properties 

 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Trend properties 
 
The recording span indicates the time to acquire 2,880 samples for each trend graph (maximum 
number of samples) in the specified sampling period. 
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For example, if the trend sampling period is 1 minute, 
1 (minute) x 2 880 samples = 2 880 minutes = 48 hours = 2 days  
2 days of process data may be recorded. 
 
Select your sample rate and click OK (In the example above we have 1 minutes for the sample rate) 
 
To select the parameters you want to trend double click on TR0001, you can trend multiple variables 
together these parameters (variables have to be in the same group) 
 

 
Group 1 configuration 

 
This will trend Power-A, Power-B and the SG-VOLT variables in the same windows as shown below 

 
Group 1 trending 
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You can have multiple groups of variables, the example below show a trend configuration for the LAS 
Signal Level in the Group02. 
 

 
Las Signal Level – Group02 

 

 
Las Signal Level 


